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Mac OS X Tiger
Fundamentals

The Macintosh operating
system, often abbreviated
Mac OS, is the software
that makes your Macintosh
computer run. It gives you
the ability to work with a
mouse, a keyboard,
windows, files, and can
even offer help when you
run into trouble. 

MMACC  OOSS  IInnttrrood
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The Finder
The Finder is an application that is
always running. It displays the
Desktop and windows where you
can work with files, folders, and
disks. 
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Run Applications
You can use the Mac OS to run
applications. Applications are tools
on your computer that help you
perform particular tasks. A word
processing application helps you
create text-based documents. A
painting application helps you to
create images. An email application
permits you to send and receive
email.

ApplicationsApplicationsApplications

Interact with the Computer
The Mac OS is the part of the
computer responsible for reading
the information that you send to it
by pressing keys on the keyboard,
clicking the mouse, or using the
trackpad. You can customize the
settings for the keyboard and
mouse in System Preferences. 

MMAACC  OOS IInttrood

The Macintosh Operating
System is a collection of
programs that makes your
computer run. It is responsible
for opening and saving files,
displaying graphics on the
screen, printing documents on a
printer, and accepting input
from the mouse and keyboard.
The Mac OS is what makes your
computer work for you. 

Mac OS 
Introduction
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Listen to and View Media
The Mac OS gives you a complete toolbox to use with
multimedia files. You can listen to music in iTunes,
catalog and view photos in iPhoto, create your own
movies in iMovie, build and burn DVDs in iDVD, and
even create your own music in GarageBand. 

Sharing
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Share Files and Hardware with Others
The Mac OS helps you connect to computers anywhere
on a local network or the Internet. You can share
information and hardware on a network. You can share
files with others or print using the same printer. 
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Surf the Internet
The Mac OS provides you with everything you need to
surf the World Wide Web. You can locate information
with search engines, read articles, communicate with
people from around the world, watch movies, do
research, or even play games. The Safari Web browser
gives you the means to view Web pages. Mail gives you
access to the world of email.

Interface with Other Equipment
The Mac OS is proficient at working with a variety of
computer hardware. From a keyboard, mouse, and
joystick to the iPod, video cameras, and cell phones, the
Mac OS gives you the opportunity to connect your
equipment to and interact with the digital hub. Your Mac
can talk to all of these types of equipment and more.
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Although it has only one button, a Mac
mouse or trackpad can perform many
different functions. You can click the
mouse once or twice to achieve
different results. Click once to select a
file or folder for use with any Finder
menu. Double-click a file or folder to
select and open it. You can also modify
a mouse click by pressing the 
key. This usually causes a contextual
menu to appear.

SINGLE-CLICK

1 Click the Finder icon in the Dock.

A Finder window opens if one is not already open.
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Documents

‘Click’
‘Click’ ‘Click’

‘Click’

Click the Mouse Once or Twice 

6

Click the Mouse 
Once or Twice 

2 Click a folder to select it.

The icon darkens to indicate that you have selected it.

3 Click File. 

4 Click Open.

The folder opens, revealing its contents.
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DOUBLE-CLICK

1 In the Finder, double-click a folder icon.

The folder opens immediately.
11

New Folder

What double-click
shortcuts will help me?
Press when you 
double-click a folder
to open the
folder in a new
Finder window.
Press 
and double-click
a folder to open it in
a new window and
to close the previous
window. 

SHORT
CUT SHORT
CUT SHORT
CUT clickclickclickclickclick

clickclickclickclickclick
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CLICK WITH A MODIFIER

1 Press and click once on the Finder
Desktop. 

A contextual menu opens revealing different
functions applicable to the Desktop.

Are there any single-click shortcuts I
can use?
You can rename a file or folder by clicking
its name in the Finder. After a brief pause,
the name appears highlighted
and waits for you to type a
new name. When you finish
typing the name, press 
to complete the change. If you
press a second time, you
can edit the file name again just as
if you had single-clicked it. If you
press , you can click multiple files
in the Finder to select them. This helps
when you want to perform an action
on multiple items at once.

SHORT
CUT SHORT
CUT SHORT
CUT clickclickclickclickclick
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One of the main tools in the Mac OS
interface is the menu. Apple designed the
Mac interface with continuity in mind.
You can click and use menus in any
application and expect to see similar
results. Menus also have similar keyboard
shortcuts to trigger their actions in many
applications. This helps you maintain a
sense of cohesion as you work with
different applications. Sometimes menus
contain hidden functions that you can
reveal by pressing a special modifier key.

CLICK A MENU

1 In the Finder, click Go.

2 Click Home.

11

22

Go

Home                           H

The Finder

New Finder Window.......$0.00

Empty Trash....................$0.00

Close Window..............$0.00

Keyboard Shortcuts.....$0.00

Settings.......................$0.00.............

Control the Mac with Menus

8

Control the Mac 
with Menus

A window opens, displaying the contents of your
Home folder.
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SELECT MENU ITEMS WITH THE KEYBOARD

1 In the Finder, press + + .

A window opens listing the contents of the Utilities
folder. 

11
File

Show Inspector                  I

Are there any keys that produce
hidden functions in the Finder
menus?
You can also press and 
to reveal hidden menu functions.
Hidden menu items appear in
place of the usual menu items
when you press either the

or key modifiers.
The keyboard shortcut icons in the
menu also change to reflect the
keys in the keystroke. 

shiftshiftshiftshiftshiftshift
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USE HIDDEN MENU CHOICES

1 Click File.

2 Press . 

l The appearance of the File menu changes and
reveals hidden functions.

3 Release with the menu still open.

The standard File menu items reappear.

Where do I find keyboard
shortcuts for menus?
Keyboard shortcuts for all
menu items appear in the
menus themselves. A
menu item displays its
shortcut to the right of its
title. For example, in the Finder
you can open a new window
by pressing + . The
keyboard shortcut appears as
the first item in the File menu
with symbols for and . 

SHORT
CUT SHORT
CUT SHORT
CUT 
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Along with menus, windows are among the
most important parts of the Mac OS
interface. Finder windows are containers
for organizing your files. You can
customize windows to match your needs
precisely. You can resize a window to reveal
something behind it or to see more files in
it. If a window gets in the way, you can
minimize it, which tucks the window nicely
away in the Dock for one click access later.
Finally, when you are finished using a
window, one simple click closes it.

OPEN A NEW WINDOW

1 In the Finder, click File.

2 Click New Finder Window.

A new Finder window opens.

11
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22

File

New Finder Window           N

Finder

Work with Finder Windows 

10

Work with 
Finder Windows 

RESIZE A FINDER WINDOW

1 Click and drag the bottom-right corner of the
window.

The window resizes as you drag.

2 Click the Zoom button ( ).

The window zooms to full size.

3 Click ( ) again.

The window returns to its original size. 
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CLOSE A FINDER WINDOW

1 In an open Finder window, click the Close 
button ( ).

The Finder window closes.
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MINIMIZE A FINDER WINDOW

1 In an open Finder window, click the Minimize
button ( ).

The window minimizes, appearing in the dock.

2 Click the icon in the Dock.

The window returns to normal size.

Why do I need to resize windows?
When you make a window larger, you can
view more of the files within that window.
When you make a window smaller, you see
less of the files and the
size of the scrollbar
changes relative to
how much of the
window contents
you cannot see.
Making a window
smaller also helps
you to see more of
other windows or the
desktop behind it. 

Are there any shortcuts that 
I can use with windows?
If you press and hold 
while clicking the close button
in a Finder window, all open
Finder windows will close. You
can cycle through the open
windows of most applications 
by pressing + repeatedly. 
Press + + to cycle through
the open windows in reverse order.
Pressing the + keyboard shortcut
causes the foremost window to
minimize in the Dock.

SHORT
CUT SHORT
CUT SHORT
CUT optionoptionoptionoption

optionoption
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You are not restricted to viewing Finder
windows in one format. You can customize
the look and feel of your Finder windows
to help you work more efficiently. You can
change the size of icons and text in Finder
windows to suit your needs. The Finder
gives you several different choices for
displaying information about files. You 
can customize these choices to change the
amount of information that appears in a
window.

OPEN VIEW OPTIONS

1 In the Finder, click View.

2 Click Show view Options.

11

22

View

Show View Options          J

Change Window View Options 

12

Change Window 
View Options 

The View Options window opens, displaying settings
for the foremost window. If no window is open, the
settings for the Desktop appear in the View Options
window instead.
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ARRANGE ICONS AUTOMATICALLY

1 In the View Options window, click Keep Arranged
By ( changes to ).

Make sure that the window is in Icon or List view,
or you will not see these settings.

2 Click and select Kind.

The icons in the window automatically sort
themselves according to file type. The Finder
maintains this automatic sorting even when you
resize a window or add and remove files.

22
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33
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11
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CHANGE ICON AND TEXT SIZE

1 In the View Options window, drag left to 16x16.

The icons appear at 16x16, the smallest size. Make
certain that the window is in Icon or List view, or
you will not see these settings.

2 Click and select 16 pt.

3 Click Right ( changes to ).

The Finder updates the window to reflect the
changes.

Can I change the white background of my
Finder windows?
You can set the background of Finder windows
using the settings that appear at the
bottom of the View Options window.
Click Color to select a color for
the background. Click Picture
to choose a picture file to use
as the window background. 
If you click All Windows, the
window background color or
image appears on any Icon
view windows that you open
thereafter. 

mountains.jpg

mountains.jpg

starrynight.png

starrynight.png

flowers.tif
flowers.tif

mountains.jpg

mountains.jpg

starrynight.png

starrynight.png

flowers.tif
flowers.tif

What does the Show Icon Preview
option in the View Options window do?
For graphics files like JPG, TIF, and PNG, 
the Finder displays a preview
of the image as an icon for
each file. That way, you
can tell what the image
contains without
opening the file to see.
You merely glance at its
preview icon. Note that
this only works for the
Icon and List views. 

mountains.jpg

starrynight.png

flowers.tif
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Applications are the main
workhorses of the Mac OS. They
are functional units that help you
perform tasks with the computer.
Some applications play music, some
display images, and others create
documents or even play games.
You can launch an application
either by clicking its icon in the
Dock or double-clicking its icon
in the Finder. 

OPEN THE APPLICATIONS FOLDER

1 In the Finder, press + + .

The Applications window opens, showing all
applications installed in the Applications folder.
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Understanding Applications 

14

Understanding 
Applications 

LAUNCH AN APPLICATION

1 In the Applications folder, double-click TextEdit.

The TextEdit application launches and opens a new
document where you can type text.

2 Click the Safari icon.

The Safari Web browser launches.
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QUIT AN APPLICATION

1 From any running application, click the application
menu.

2 Click Quit.

The application stops.

11

TextEdit

Quit TextEdit            Q
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22

22
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LOCATE RUNNING APPLICATIONS

1 In the Dock, locate the small black triangles
that appear beneath running applications. 

2 Click an icon of a running application.

The application comes to the foreground.

Are there other applications available
to me in case the applications in OS X
do not provide what I need?
You can download literally thousands of
applications on the Internet, many of which
are free or available for a small fee. There
are applications to perform almost any
task imaginable. With applications,
you can track your music and book
collection, play a game of golf,
draw a picture, balance your
checkbook, or even learn to
juggle. Two of the most popular
software download sites 
are www.versiontracker.com and
www.macupdate.com.

www.webbrowser.com

TOOLS FOR

ANY TASK!

What kinds of things can I do
with the applications that come
installed with Mac OS and
iLife?
You can perform a wide variety of
tasks with the applications that
accompany OS X. You can listen 
to, catalog, and record music.
You can organize, edit, and
share photos, create word
processing documents,
keep track of addresses,
email friends, surf the
Internet, watch and create
movies, make calendars, and
play chess.
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The Dock is a one-stop utility that
performs different tasks. You can
launch applications from the Dock,
see which applications are running,
and give yourself one-click access to
commonly used files. You can quit
applications by clicking icons in the
Dock. You can also add folders to
the Dock, so you can access all of its
contents with a single click. 

LAUNCH AN APPLICATION FROM THE DOCK

1 In the Dock, click Safari.

The Safari Web browser launches.

22
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Using the Dock

16

Using 
the Dock

QUIT AN APPLICATION FROM THE DOCK

1 In the Dock, click the icon of a running application
and continue holding the mouse button.

l A pop-up menu lists functions for the application.

2 Click Quit.

The application stops.
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ADD A FOLDER TO THE DOCK

1 In the Finder, press + + to open
your Home folder.

2 Click and drag the Pictures folder from the Home
folder to a position on the Dock.

An icon appears in the Dock.

3 Click the Pictures folder icon in the Dock to open
the Pictures folder.

22

33

11

Pictures

Why is there a vertical line
on the Dock?
The vertical line in the Dock
separates applications from
the files and folders that you
place in the Dock. 
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REMOVE A FILE FROM THE DOCK

1 Click and drag an application, document, or file icon
from the Dock to the Desktop.

The icon disappears from the Dock in an animated
puff of smoke. 

If I remove an icon from the
Dock, does it erase that item
from the hard drive?
No. The elements in the Dock
are simply pointers to
applications, files, or
folders that those icons
represent. Removing
the icons from the
Dock does nothing
more than remove the
icon from the Dock. It
does not affect any
application, file, or folder. 

poof!

poof!

poof!

poof!

poof!
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You can switch between all
running applications with one
keystroke. The Application
Switcher takes care of switching
applications when you press the
keystroke. You can also control
the Application Switcher with
the keyboard to make switching
even easier.

SWITCH TO ANOTHER APPLICATION

1 Press + .

The Application Switcher displays all running applications.

2 While holding down , press again.

l The Application Switcher highlights the next icon in the list.

3 When the application you want to launch is highlighted, release .

The highlighted application comes to the foreground.

4 While holding down + , press .

The Application Switcher highlights the previous icon.

SWITCH APPLICATIONS WITH ARROW KEYS

1 Press + .

The Application Switcher appears, displaying icons of all running
applications.

2 While holding down , press .

l The Application Switcher highlights the next icon in the list.

3 While holding , press .

The Application Switcher highlights the previous icon in the list.

4 When the icon for the application you want to launch is highlighted,
release .

The highlighted application comes to the foreground.

Safari
iChat

E-Mail

Chat
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Applications

AApplliiccattionss
Safari

iChat

E-Mail

Toggle Applications
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Toggle 
Applications
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Mac OS X Tiger Fundamentals

Mac OS is a multiuser operating
system, which means that more
than one user can use the same
computer with personalized settings
that each user determines and
controls. To use the computer, you
must login using your user name
and password. Logging in can
prevent other users from changing
your settings or using your
account. 

LOG OUT

1 Click the Apple icon ( ).

2 Click Log Out Username.

A window appears asking you to confirm your
logout operation.

3 Click the Logout button.

Your account logs out and displays the Login
dialog box. 

Log Out Erick...                    Q

11

22

11

Log in Log out

Logging In and Out
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19

Logging In 
and Out

LOG IN

1 Click a user icon.

2 Type your password into the password field that
appears.

3 Click Login.

The computer logs you in.
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You can put your computer to
sleep instead of shutting it
down. A sleeping Mac uses very
little energy and has the benefit
of allowing instant-on access to
your computer. These features
are especially useful for laptops,
which rely on battery power that
you need to conserve. 

MAKE THE MAC GO TO SLEEP

1 Click .

2 Click Sleep.

The Mac goes to sleep and displays nothing on the
screen. Sleep

11

22
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Put Your Mac to Sleep

20

Put Your 
Mac to Sleep

3 Press any key, or click the mouse or trackpad.

The computer awakens instantly, permitting you to
pick up where you left off when you put the
computer to sleep.
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MAKE A LAPTOP SLEEP

1 To put an iBook or PowerBook to sleep, simply close
the laptop lid.

The computer goes to sleep, and on some models a
pulsating light appears on the outside cover
indicating sleep.

Mac OS X Tiger Fundamentals
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2 Open the laptop, and press any key or click the
trackpad.

The computer awakens to where you last worked.

Do I have to worry about the battery
running out while sleeping?
Although the computer uses a low-power 
mode during sleep, it is still using
battery power that can cause
the battery to drain. When
a laptop battery gets
below a certain level of
remaining power, the
Mac shuts off
automatically, which
means that you could
lose unsaved data. bbattery lo

w

battery lo
w
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ut 
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What happens when a Mac is in
sleep mode?
When you put a Mac to sleep, it disables
the network settings and puts the
computer in a low-power
mode. It will remember
unsaved documents
that you were working
on, but it will not
permit file sharing 
on the network. 

04_576984 ch01.qxd  4/21/05  7:36 PM  Page 21



Although a Macintosh can run
nonstop for days and weeks on end,
there are times when you may need to
shut down or restart a Mac. It is useful
to shut down a computer when you
need to move the machine, when there
is an electrical storm, or when you
want to install new hardware.
Restarting a Mac is required after some
software installations and also
sometimes helps fix an errant machine.

RESTART A MAC

1 Click the Apple icon.

2 Click Restart.

A dialog box appears asking you to approve the
restart.

Restart...

11

22

33

ON

OFF

RESTART

Restart or Shut Down the Mac

22

Restart or Shut 
Down the Mac

3 Click Restart.

The computer restarts.
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SHUT DOWN

1 Click .

2 Click Shut Down.

A dialog box asks you to approve the shutdown
process.

Shut Down...

11

22

33

When should I shut down
a computer instead of
put it to sleep?
You should shut down a
Mac before physically
moving it or disconnecting
its power source. It is also
probably a good idea to
shut down and disconnect
the power to a computer
during an electrical storm. If
you do not plan on doing any of
the aforementioned tasks, you can
safely use the sleep function instead.

SHUTSHUT
DOWNDOWN
SHUTSHUT

DOWNDOWN
SHUT

DOWN
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3 Click Shut Down.

The computer shuts down.

What happens when my
computer restarts?
If you have the default 
single-user settings in the
Users pane of the System
Preferences, your computer
restarts and your Desktop
appears. If you use a
computer in a multiuser
environment, you may have
to provide a login username
and password when you
restart the computer.

restartrestartrestartrestartrestart
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If you get stuck while using your
Mac, you can sometimes get out
of a jam by consulting the
Finder’s built-in Help system.
The Help system contains
valuable information about
using both hardware and
software related to the Mac. 

LAUNCH HELP FOR THE FINDER

1 In the Finder, click Help.

2 Click Mac Help.

?? ? ? ? ? ??

Helpp  DDeesskkHeelpp  Deessk

Get Help

24

Get 
Help

The Help Viewer launches and displays helpful
information about the Finder. 

Help

Mac Help          ?

11
22
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FIND ANSWERS

1 In the Help Viewer, type a question into the Search
field.

2 Press .

11

Is the Help system limited
to information for Apple
applications only?
The Help menu 
can display useful
information for 
any application
that includes built-
in Help. You can
search any installed
Help modules just as
you would search the
one for the Finder. 

i chat
i chat
i chat

Finder HelpFinder HelpFinder Help
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The Help Viewer finds answers to your question and
displays the results.

I know how to use the Finder.
Can I locate help for other
applications too?
The Help menu in 
all applications is
context-specific.
When you click Help,
the Help Viewer
application displays
information specific
to the current
application. 
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